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WalkMe content guide for New EXCOL 
Last Updated: December 2022  

Introduction 
The following alternative accessibility document outlines and explains the WalkMe content on the New 
EXCOL web interface. WalkMe relies on CSS coding to interact with the web interface. Enabling CSS will 
allow the user the ability to interact with the WalkMe content. If CSS is disabled, the WalkMe content 
will not appear on the New EXCOL. This document provides the WalkMe content in the event that CSS is 
disabled.  

WalkMe provides the user with a visual Digital Adoption Platform tool to enhance user experience. It 
allows a passive and active engagement with the application that assists users in navigating the site, 
including guided step by step tours, and helpful information on various objects and fields within the 
New EXCOL. It also provides contact information for obtaining support, and providing feedback to Global 
Affairs Canada. 

For any questions, comments, and suggestions regarding this document, please send an email to the 
following address: feedback.commentaire-tia@international.gc.ca. 

Glossary 
There are various types of WalkMe content on the New EXCOL web page.  

Walk-Through: An interactive step-by-step guide that provides a thorough description of the New 
EXCOL page features and instructions on how to complete and submit applications. Walk-Throughs 
appear in the form of bubbles and pop-up windows overlaid on the New EXCOL to bring attention to 
various key components on the pages. 

SmartTip: Short text that provides advice, descriptions and useful external links regarding New EXCOL 
content. SmartTips appear in the form of Mouseovers (appears when hovering and tabbing over New 
EXCOL content) and Tooltips (small blue icons with a white question mark by New EXCOL titles and text 
boxes) throughout the New EXCOL 

Launcher: A button on the New EXCOL that opens various WalkMe content, such as Walk-Throughs, and 
ShoutOuts. Launchers will also open external resources on a new browser tab. 

ShoutOut: A pop-up window that broadcasts important information regarding the New EXCOL. They can 
also provide advice, descriptions, and useful links regarding New EXCOL content. ShoutOuts are 
automatically played or are accessible through a launcher.  

Survey: A pop-up window that gathers feedback regarding user experience. The feedback obtained from 
surveys is sent to Global Affairs Canada in order to improve New EXCOL, and WalkMe content. 
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General Features 
SmartTips 
There is a SmartTip found on various or all New EXCOL pages.  
1. MENU (Tooltip): Click on Menu to view the dropdown options. Click again to close the Menu. 
2. NEXCOL (Tooltip): Hover over or click on one of the Menu buttons to view the dropdown 

options and hover or click away to close them. 

WalkMe Help Menu 
The WalkMe Help Menu is a centralized repository for important resources and Walk-Throughs. The 
Help Menu does not include all WalkMe content. 

WalkMe Help Menu: Contact Information 
1. EXCOL Help Desk for Support: For Support regarding New EXCOL, please use the following address: 

excol-ceed.tia@international.gc.ca. 
2. New EXCOL Feedback: To provide feedback regarding the New EXCOL, please use the following 

address: feedback-commentaire.tia@international.gc.ca. 
3. Contact Us: EXCOL Contact Information 

WalkMe Help Menu: Resources 
Clicking the Resources drop down link will open a list with the following links. 
1. A Guide to Canada's Export Control List 
2. Brokering Control List 
3. Canadian Firearms Legal Classification 
4. Exporter and Brokering Controls Handbook 

WalkMe Help Menu: Step by Step Application Walk-Throughs 
Clicking the Step by Step Application Walk-Throughs drop down will open a list with the following 
Application Walk-Through links. 
1. Apply – Advisory Opinion: See section AO: From the WalkMe Help Menu launcher, step 3., to begin 

the Application Walk-Through. 
2. Apply – B.C. Logs: See section BC Logs: From the WalkMe Help Menu launcher, step 3., to begin the 

Application Walk-Through. 
3. Apply – Brokering Permit: See section BP: From the WalkMe Help Menu launcher, step 3., to begin 

the Application Walk-Through. 
4. Apply – Delivery Verification Certificate: See section DVC: From the WalkMe Help Menu launcher, 

step 3., to begin the Application Walk-Through. 
5. Apply – Firearms, Ammunition, and Firearm Related Goods (FARG): See section FARG: From the 

WalkMe Help Menu launcher, step 3., to begin the Application Walk-Through. 
6. Apply – General Export Permit (GEP) Pre-notification: See section GEP: From the WalkMe Help 

Menu launcher, step 3., to begin the Application Walk-Through. 
7. Apply – International Import Certificate: See section IIC: From the WalkMe Help Menu launcher, 

step 3., begin the Application Walk-Through. 
8. Apply – Non B.C. Logs: See section Non BC Logs: From the WalkMe Help Menu launcher, step 3., to 

begin the Application Walk-Through. 



4 
 

9. Apply – Other Controlled Goods: See section OCG: From the WalkMe Help Menu launcher, step 3., 
to begin the Application Walk-Through. 

Website Guide 
The Website Guide is a WalkMe launcher found on all New EXCOL pages. Clicking the Website Guide 
launcher will open a pop-up with the information below. 

Website Guide: Apply 
Clicking the Apply link in the Website Guide pop-up will open a pop-up with the types of applications 
below. 

1. Firearms, Ammunition, and Firearms Related Goods (FARG): See section FARG: From the Website 
Guide launcher, step 4., to begin the Application Walk-Through. 

2. Other Controlled Goods (OCG): See section OCG: From the Website Guide launcher, step 4., to begin 
the Application Walk-Through. 

3. General Export Permit (GEP): See section GEP: From the Website Guide launcher, step 4., to begin 
the Application Walk-Through. 

4. Advisory Opinion (AO): See section AO: From the Website Guide launcher, step 4., to begin the 
Application Walk-Through 

5. Delivery Verification Certificate (DVC): See section DVC: From the Website Guide launcher, step 4., 
to begin the Application Walk-Through. 

6. International Import Certificate (IIC): See section IIC: From the Website Guide launcher, step 4., to 
begin the Application Walk-Through. 

7. Brokering Permit (BP): See section BP: From the Website Guide launcher, step 4., to begin the 
Application Walk-Through 

8. B.C. Logs: See section BC Logs: From the Website Guide launcher, step 4., to begin the Application 
Walk-Through. 

9. Non B.C. Logs: See section Non BC Logs: From the Website Guide launcher, step 4., to begin the 
Application Walk-Through. 

Website Guide: Contact Us 
EXCOL contact information 

Website Guide: Menu Walk-Through  
Clicking the Menu link in the pop-up will start a Walk-Through of the Menu. 
1. Dynamic Menu - The menu is now displayed in a row of dropdowns. 
2. Home - Clicking on the Home page will bring you back to your default work queue. 
3. Apply - Under “Apply”, you can view the types of Applications you can submit. Hover the Apply 

dropdown for more options.  
4. References - You can find various links and resources, including the Contact Us page and the Export 

and Brokering Controls Handbook, under “References”. Hover over the References dropdown for 
more options.  

5. Page Footer -The footer at the bottom of each page also contains many helpful links relating to 
import and export! 

6. Sign-In - Clicking the Sign-In button is your secure wat of logging in to your account.  
7. That’s it! - You have now seen the menu and its features.  

Website Guide: Support 
See section Support, steps 1. and 2., for information on the Support contact information. 
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Support 
The Support launcher is a WalkMe component found on all New EXCOL pages. Clicking the Support 
launcher will open a pop-up with the information below. 

1. Support: For Support regarding New EXCOL, please use the following address: excol-
ceed.tia@international.gc.ca. 

2. Feedback: To provide feedback regarding the New EXCOL, please use the following address: 
feedback-commentaire.tia@international.gc.ca.  
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New EXCOL Application types 
British Columbia Logs (BC Logs) 
BC Logs: Application Walk-Through 
BC Logs: How to Access the Walk-Through 
You can access the B.C. Logs Walk-Through in three ways. 

BC Logs: From the Website Guide launcher 
1. Click the Website Guide launcher (on all New EXCOL pages). 
2. On the Website Guide pop-up click the Apply link.  
3. On the Application Walk-Through Menu pop-up click the B.C. Logs link. This will launch a pop-up 

advising you that in beginning this application Walk-Through, you may loose any unsaved 
information.  

4. Click the Start button in the pop-up. You will be redirected to the Terms of User and Privacy 
Statement page. 

5. Click the I Agree button in the application. You will be redirected to the B.C. Logs application 
webpage. See section BC Logs: Walk-Through Step. (The pop-up also gives you the option to cancel 
the Walk-Through. Click the Cancel button in the pop-up to stop the Walk-Through.) 

BC Logs: From the WalkMe Help Menu launcher  
1. Click the WalkMe Help Menu launcher (large question mark icon at the bottom of all New EXCOL 

pages).  
2. On the Help Menu-WalkMe pop-up, click the Step by Step Application Walk-Throughs drop down 

link.  
3. From the drop down, click the Apply – B.C. Logs link. This will launch a pop-up advising you that in 

beginning this application Walk-Through, you may loose any unsaved information. 
4. Click the Start button in the pop-up. You will be redirected to the Terms of User and Privacy 

Statement page. 
5. Click the I Agree button in the application. You will be redirected to the B.C. Logs application 

webpage. See section BC Logs: Walk-Through Step. (The pop-up also gives you the option to cancel 
the Walk-Through. Click the Cancel button in the pop-up to stop the Walk-Through.) 

BC Logs: From the Help launcher on the General page  
1. Click the Help launcher on the General page of the B.C. Logs Application. See section BC Logs: Walk-

Through Step. 

BC Logs: Walk-Through Step 
1. Application Walk-Through Disclaimer 
1.1. A pop-up advises you that by following the B.C. Logs application Walk-Through you will be 

submitting an actual application. 
1.2. Click the Start button in the pop-up. (The pop-up also gives you the option to cancel the Walk-

Through. Click the Cancel button in the pop-up to stop the Walk-Through.) 
1.3. A pop-up advises you to click the Application Guidelines dropdown menu to view information 

specific to your application. 
1.4. Read the Application Guidelines. 
1.5. Click the Next button in the pop-up. 
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2. General tab: There are two Land Category options on the B.C. Logs application: Provincial, and 
Indian Reserve Land. The Land Category you select on the General page will determine the 
information you must complete on the New EXCOL Items page. Keep note of the Land Category you 
select, as it will be important once you begin step 6. later in the Walk-Through process. If you are 
submitting a transitional application, please enter your AA Reference Number on the Items tab, as 
you would for a regular application, the system will treat this as a transitional application, as the 
Reference number will have already been used in a previous permit. 

2.1. Complete the required fields. 
2.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.) 

3. Applicant tab 
3.1. Confirm that you are a Canadian Resident. 
3.2. Complete the required fields.  
3.3. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

4. Exporter tab 
4.1. Click the Same as Applicant checkbox, or manually complete the required fields. 
4.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

5. Consignee tab 
5.1. Complete the required fields.  
5.2. Click on the Accept button in the application to save. (If any mistakes are made while completing 

the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click the Accept button to save.) 

5.3. To add an additional consignee record, click on the Add Consignee button in the application and 
repeat step 5.1. onwards. Once you have added your consignee(s), click on one of the two Next 
buttons in the application to continue.  

6. Items tab: There are two Land Category options on the B.C. Logs application: Provincial, and Indian 
Reserve Land. The Land Category you selected on the General page determines the set of Walk-
Through step you must follow. If you selected Provincial as the Land Category on the General page, 
see step 6.1. If you selected Indian Reserve Land, see step 6.2. 

6.1. Provincial lands 
6.1.1. Complete the required fields.  
6.1.2. Click on the Accept button in the application to save. (If any mistakes are made while 

completing the form, an error message will appear on the application advising you on what to 
modify. Correct the errors. Click the Accept button to save.) 

6.1.3. To add an additional item record, click on the Add Item button in the application and repeat 
step 6.1.1. onwards. Once you have added your item(s), click on one of the two Next buttons in 
the application to continue, and see step 7.  

6.2. Indian Reserve lands 
6.2.1. Complete the required fields.  
6.2.2. Click on the Add Summary of Scale button in the application to save. 
6.2.3. To add an additional summary of scale record, click on the Add Summary of Scale button in the 

application and repeat step 6.2.1. onwards. Once you have added your Summary of Scale 
Record(s), click Accept button in the application.  
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6.2.4. To add an additional item record, click on the Add Item button in the application and repeat 
step 6.2.1. onwards. Once you have added your item(s), click on one of the two Next buttons in 
the application to continue. 

7. Documents tab: Click the Add Document button in the application if they are required to meet your 
application requirements or if you would like to add document(s), and see step 7.1. If you do not 
want to add documents, click on one of the two Next buttons in the application to continue and see 
step 8. 

7.1. Complete the required fields.  
7.2. Click on the Add Document button in the application to save. (If any mistakes are made while 

completing the form, an error message will appear on the application advising you on what to 
modify. Correct the errors. Click the Accept button to save.) 

7.3. To add an additional document record, click on the Add Document button in the application and 
repeat step 7.2. onwards. Once you have added your document(s), click on one of the two Next 
buttons in the application to continue. 

8. Distribution tab 
8.1. Complete the required fields.  
8.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click Accept button to save.)  

9. Applicant Confirmation tab 
9.1. Complete the required fields.  
9.2. Click on one of the two Submit buttons in the application to complete your permit submission. (If 

any mistakes are made while completing the form, an error message will appear on the 
application advising you on what to modify. Correct the errors. Click one of the two Submit 
buttons to continue.) 

10. Confirmation of Application Submission 
10.1. You have now completed your application submission. You will be prompted to leave feedback on 

your experience using the Walk-Through. To provide feedback please send an email to the 
following address: feedback-commentaire.tia@international.gc.ca. 

BC Logs: SmartTips 
BC Logs: General tab 
1. Applicant comments (Mouseover): Applicant Comments will only be visible to Permit Officers and 

will not be printed on the permit. 

BC Logs: Consignee tab 
1. Name (Tooltip): The Consignee is the foreign party or parties who will be importing the goods or 

technology from the Canadian exporter into a foreign country. 

BC Logs: Documents tab 
1. Documents (Tooltip): Refer to Notice 102 of the Export of Logs from British Columbia   for guidance 

on appropriate documentation. 
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Non British Columbia Logs (Non BC Logs) 
Non BC Logs: Application Walk-Through 
Non BC Logs: How to Access the Walk-Through 
You can access the Non B.C. Logs Walk-Through in three ways.  

Non BC Logs: From the Website Guide launcher 
1. Click the Website Guide launcher (on all New EXCOL pages). 
2. On the Website Guide pop-up click the Apply link.  
3. On the Apply pop-up click the Export Permit Applications link. 
4. On the Export Permit Applications pop-up click the Non B.C. Logs link. This will launch a pop-up 

advising you that in beginning this application Walk-Through, you may loose any unsaved 
information.  

5. Click the Start button in the pop-up. You will be redirected to the Terms of User and Privacy 
Statement page. 

6. Click the I Agree button in the application. will be redirected to the Non B.C. Logs application 
webpage. See section Non BC Logs: Walk-Through Step. (The pop-up also gives you the option to 
cancel the Walk-Through. Click the Cancel button in the pop-up to stop the Walk-Through.) 

Non BC Logs: From the WalkMe Help Menu launcher 
1. Click the WalkMe Help Menu launcher (large question mark icon at the bottom of all New EXCOL 

pages).  
2. On the Help Menu-WalkMe pop-up, click the Step by Step Application Walk-Throughs drop down 

link.  
3. From the drop down, click the Apply – Non B.C. Logs link. This will launch a pop-up advising you that 

in beginning this application Walk-Through, you may loose any unsaved information. 
4. Click the Start button in the pop-up. You will be redirected to the Terms of User and Privacy 

Statement page. 
5. Click the I Agree button in the application. You will be redirected to the Non B.C. Logs application 

webpage. See section Non BC Logs: Walk-Through Step. (The pop-up also gives you the option to 
cancel the Walk-Through. Click the Cancel button in the pop-up to stop the Walk-Through.) 

Non BC Logs: From the Help launcher on the General page 
1. Click the Help launcher on the General page of the Non B.C. Logs Application. See section Non BC 

Logs: Walk-Through Step.  

Non BC Logs: Walk-Through Step 
1. Application Walk-Through disclaimer 
1.1. A pop-up advises you that by following the Non B.C. Logs application Walk-Through you will be 

submitting an actual application. 
1.2. Click the Start button in the pop-up. (The pop-up also gives you the option to cancel the Walk-

Through. Click the Cancel button in the pop-up to stop the Walk-Through.)  
1.3. A pop-up advises you to click the Application Guidelines dropdown menu to view information 

specific to your application. 
1.4. Read the Application Guidelines. 
1.5. Click the Next button in the pop-up. 
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2. General tab 
2.1. Complete the required fields.  
2.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.) 

3. Applicant tab 
3.1. Confirm that you are a Canadian Resident. 
3.2. Complete the required fields. 
3.3. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

4. Exporter tab 
4.1. Click the Same as Applicant checkbox, or manually complete the required fields.  
4.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

5. Consignee tab 
5.1. Complete the required fields.  
5.2. Click on the Accept button in the application to save. (If any mistakes are made while completing 

the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click the Accept button to save.) 

5.3. To add an additional consignee record, click on the Add Consignee button in the application and 
repeat step 5.1 onwards. Once you have added your consignee(s), click on one of the two Next 
buttons in the application to continue. 

6. Items tab 
6.1. Complete the required fields.  
6.2. Click on the Accept button in the application to save. (If any mistakes are made while completing 

the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click the Accept button to save.) 

6.3. To add an additional item record, click on the Add Item button in the application and repeat step 
6.1. onwards. Once you have added your item(s), click on one of the two Next buttons in the 
application to continue.  

7. Documents tab: Click the Add Document button in the application if they are required to meet your 
application requirements or if you would like to add document(s). If you would like to add 
documents, see step 7.1. If you do not want to add documents, click on one of the two Next buttons 
in the application to continue and see step 8. 

7.1. Complete the required fields.  
7.2. Click on the Accept button in the application to save. (If any mistakes are made while completing 

the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click Accept button to save.) 

7.3. To add an additional document record, click on the Add Document button in the application and 
repeat step 7.1. onwards. Once you have added your document(s), click on one of the two Next 
buttons in the application to continue.  

8. Distribution tab 
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8.1. Complete the required fields. 
8.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

9. Applicant Confirmation tab 
9.1. Complete the required fields. 
9.2. Click on one of the two Submit buttons in the application to complete your permit submission. (If 

any mistakes are made while completing the form, an error message will appear on the 
application advising you on what to modify. Correct the errors. Click one of the two Submit 
buttons to continue.) 

10. Confirmation of Application Submission 
10.1. You have now completed your application submission. You will be prompted to leave feedback on 

your experience using the Walk-Through. To provide feedback please send an email to the 
following address: feedback-commentaire.tia@international.gc.ca. 

Non BC Logs: SmartTips 
Non BC Logs: General tab 
1. Applicant comments (Mouseover): Applicant Comments will only be visible to Permit Officers and 

will not be printed on the permit. 

Non BC Logs: Exporter tab 
1. EIPA Number (Tooltip): Upon copy – validation of the EIPA number on the Exporter tab is no longer 

done automatically – please go to exporter tab to validate the EIPA number to expedite processing 
of your application. 

Non BC Logs: Consignee tab 
1.  Name (Tooltip): The Consignee is the foreign party or parties who will be importing the goods or 
technology from the Canadian exporter into a foreign country. 
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Firearms, Ammunition and Firearm Related Goods (FARG) 
FARG: Application Walk-Through 
FARG: How to Access the Walk-Through 
You can access the Firearms, Ammunition and Firearm Related Goods (FARG) Walk-Through in three 
ways.  

FARG: From the Website Guide launcher 
1. Click the Website Guide launcher (on all New EXCOL pages). 
2. On the Website Guide pop-up click the Apply link.  
3. On the Apply pop-up click the Export Permit Applications link. 
4. On the Export Permit Applications pop-up click the Firearms, Ammunition and Firearm Related 

Goods (FARG) link. This will launch a pop-up advising you that in beginning this application Walk-
Through, you may loose any unsaved information.  

5. Click the Start button in the pop-up. You will be redirected to the Terms of User and Privacy 
Statement page. 

6. Click the I Agree button in the application. You will be redirected to the Firearms, Ammunition and 
Firearm Related Goods (FARG) application webpage. See section FARG: Walk-Through Step. (The 
pop-up also gives you the option to cancel the Walk-Through. Click the Cancel button in the pop-up 
to stop the Walk-Through.) 

FARG: From the WalkMe Help Menu launcher  
1. Click the WalkMe Help Menu launcher (large question mark icon at the bottom of all New EXCOL 

pages).  
2. On the Help Menu-WalkMe pop-up, click the Step by Step Application Walk-Throughs drop down 

link.  
3. From the drop down, click the Apply – Firearms, Ammunition and Firearm Related Goods (FARG) 

link. This will launch a pop-up advising you that in beginning this application Walk-Through, you may 
loose any unsaved information. 

4. Click the Start button in the pop-up. You will be redirected to the Terms of User and Privacy 
Statement page. 

5. Click the I Agree button in the application. You will be redirected to the Firearms, Ammunition and 
Firearm Related Goods (FARG) application webpage. See section FARG: Walk-Through Step. (The 
pop-up also gives you the option to cancel the Walk-Through. Click the Cancel button in the pop-up 
to stop the Walk-Through.) 

FARG: From the Help launcher on the General page  
1. Click the Help launcher on the General page of the Firearms, Ammunition and Firearm Related 

Goods (FARG) Application. See section FARG: Walk-Through Step. 

FARG: Walk-Through Step 
1. Application Walk-Through disclaimer 
1.1. A pop-up advises you that by following the Firearms, Ammunition and Firearm Related Goods 

(FARG) application Walk-Through you will be submitting an actual application. 
1.2. Click the Start button in the pop-up. (The pop-up also gives you the option to cancel the Walk-

Through. Click the Cancel button in the pop-up to stop the Walk-Through.)  
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1.3. A pop-up advises you to click the Application Guidelines dropdown menu to view information 
specific to your application. 

1.4. Read the Application Guidelines. 
1.5. Click the Next button in the pop-up. 
2. General tab 
2.1. Complete the required fields.  
2.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.) 

3. Applicant tab 
3.1. Confirm that you are a Canadian Resident. 
3.2. Complete the required fields.  
3.3. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

4. Exporter tab 
4.1. Click the Same as Applicant checkbox, or manually complete the required fields.  
4.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

5. Consignee tab 
5.1. Complete the required fields.  
5.2. Click on the Accept button in the application to save. (If any mistakes are made while completing 

the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click the Accept button to save.) 

5.3. To add an additional consignee record, click on the Add Consignee button in the application and 
repeat step 5.1. onwards. Once you have added your consignee(s), click on one of the two Next 
buttons in the application to continue.  

6. Items tab  
6.1. Select an item type then complete the required fields. 
6.2. Click on the Accept button in the application to save. (If any mistakes are made while completing 

the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click the Accept button to save.) 

6.3. To add an additional item record, click on the Add Item button in the application and repeat step 
6.1. onwards. Once you have added your item(s), click on one of the two Next buttons in the 
application to continue.  

7. Documents tab: Click the Add Document button in the application if they are required to meet your 
application requirements or if you would like to add document(s), and see step 7.1. If you do not 
want to add documents, click on one of the two Next buttons in the application to continue and see 
step 8.  

7.1. Complete the required fields.  
7.2. Click on the Accept button in the application to save. (If any mistakes are made while completing 

the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click the Accept button to save.) 

7.3. To add an additional document record, click on the Add Document button in the application and 
repeat step 7.1. onwards. Once you have added your document(s), click on one of the two Next 
buttons in the application to continue. 

8. Distribution tab 
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8.1. Complete the required fields. 
8.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

9. Applicant Confirmation tab 
9.1. Complete the required fields.  
9.2. Click on one of the two Submit buttons in the application to complete your permit submission. (If 

any mistakes are made while completing the form, an error message will appear on the 
application advising you on what to modify. Correct the errors. Click one of the two Submit 
buttons to continue.) 

10. Confirmation of Application Submission 
10.1. You have now completed your application submission. You will be prompted to leave feedback on 

your experience using the Walk-Through. To provide feedback please send an email to the 
following address: feedback-commentaire.tia@international.gc.ca. 

FARG: SmartTips 
FARG: General tab  
1. Export Type (ToolTip): Select “Temporary” if the goods you are exporting are returning to Canada. 
2. Applicant comments (Mouseover): Applicant Comments will only be visible to Permit Officers and 

will not be printed on the permit.  

FARG: Items tab 
FARG: Ammunition 
1. ECL Code (Tooltip): Consult A Guide to Canada’s Export Control List (ECL) to determine which of the 

ECL Items apply to your item. Do not use Harmonized System (HS) codes. 
2. Quantity (Tooltip): If the Licence Type is "Individual", the Applicant may only export one (1) firearm 

per line item. See section J.2. 'Export Permit Requirements for Firearms' of the Export and Brokering 
Controls Handbook for additional guidance. 

3. U.S. Content (%) (Tooltip): U.S.-origin value is an estimated percentage of the total value in 
Canadian dollars. Refer to section E.3.9. "EXCOL Field: U.S. Content” and section E.4.3. "U.S. Export 
Authorization” of the Export and Brokering Controls Handbook for additional information 

4. Calibre (Tooltip): For "Receiver Blank" or "Receiver Only", enter Calibre = N/A 

FARG: Firearms 
1. ECL Code (Tooltip): Consult A Guide to Canada’s Export Control List (ECL) to determine which of the 

ECL Items apply to your item. Do not use Harmonized System (HS) codes. 
2. Quantity (Tooltip): If the Licence Type is "Individual", the Applicant may only export one (1) firearm 

per line item. See section J.2. 'Export Permit Requirements for Firearms' of the Export and Brokering 
Controls Handbook for additional guidance. 

3. U.S. Content (%) (Tooltip): U.S.-origin value is an estimated percentage of the total value in 
Canadian dollars. Refer to section E.3.9. "EXCOL Field: U.S. Content” and section E.4.3. "U.S. Export 
Authorization” of the Export and Brokering Controls Handbook for additional information. 

4. Canadian Firearms Legal Classification (Launcher) 
5. FRT Number (Launcher) 
6. Calibre (Tooltip): For "Receiver Blank" or "Receiver Only", enter Calibre = N/A. (The Calibre Tooltip 

only appears when the Type is “Receiver Blank” or “Receiver Only”.) 
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FARG: Firearm Related Goods 
1. ECL (Tooltip): Consult A Guide to Canada’s Export Control List (ECL) to determine which of the ECL 

Items apply to your item. Do not use Harmonized System (HS) codes. 
2. Quantity (Tooltip): If the Licence Type is "Individual", the Applicant may only export one (1) firearm 

per line item. See section J.2. 'Export Permit Requirements for Firearms' of the Export and Brokering 
Controls Handbook for additional guidance. 

3. U.S. Content (%) (Tooltip): U.S.-origin value is an estimated percentage of the total value in 
Canadian dollars. Refer to section E.3.9. "EXCOL Field: U.S. Content” and section E.4.3. "U.S. Export 
Authorization” of the Export and Brokering Controls Handbook for additional information. 

4. Prohibited Device (Launcher) 

FARG: Documents Tab 
1. Documents (ToolTip): Please refer to section E.4 “Mandatory Supporting Documentation” of the 

Export and Brokering Controls Handbook for guidance on appropriate documentation. 
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Other Controlled Goods (OCG) 
OCG: Application Walk-Through 
OCG: How to Access the Walk-Through 
You can access the Other Controlled Goods (OCG) Walk-Through in three ways.  

OCG: From the Website Guide launcher 
1. Click the Website Guide launcher (on all New EXCOL pages). 
2. On the Website Guide pop-up click the Apply link.  
3. On the Apply pop-up click the Export Permit Applications link. 
4. On the Export Permit Applications pop-up click the Other Controlled Goods (OCG) link. This will 

launch a pop-up advising you that in beginning this application Walk-Through, you may loose any 
unsaved information.  

5. Click the Start button in the pop-up. You will be redirected to the Terms of User and Privacy 
Statement page. 

6. Click the I Agree button in the application. You will be redirected to the Other Controlled Goods 
(OCG) application webpage. See section OCG: Walk-Through Step. (The pop-up also gives you the 
option to cancel the Walk-Through. Click the Cancel button in the pop-up to stop the Walk-
Through.) 

OCG: From the WalkMe Help Menu launcher  
1. Click the WalkMe Help Menu launcher (large question mark icon at the bottom of all New EXCOL 

pages).  
2. On the Help Menu-WalkMe pop-up, click the Step by Step Application Walk-Throughs drop down 

link.  
3. From the drop down, click the Apply – Other Controlled Goods (OCG) link. This will launch a pop-up 

advising you that in beginning this application Walk-Through, you may loose any unsaved 
information. 

4. Click the Start button in the pop-up. You will be redirected to the Terms of User and Privacy 
Statement page. 

5. Click the I Agree button in the application. You will be redirected to the Other Controlled Goods 
(OCG) application webpage. See section OCG: Walk-Through Step. (The pop-up also gives you the 
option to cancel the Walk-Through. Click the Cancel button in the pop-up to stop the Walk-
Through.) 

OCG: From the Help launcher on the General page 
1. Click the Help launcher on the General page of the Other Controlled Goods (OCG) Application. See 

section OCG: Walk-Through Step. 

OCG: Walk-Through Step 
1. Application Walk-Through disclaimer. 
1.1. A pop-up advises you that by following the Other Controlled Goods (OCG) application Walk-

Through you will be submitting an actual application. 
1.2. Click the Start button in the pop-up. (The pop-up also gives you the option to cancel the Walk-

Through. Click the Cancel button in the pop-up to stop the Walk-Through.) 
1.3. A pop-up advises you to click the Application Guidelines dropdown menu to view information 

specific to your application. 
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1.4. Read the Application Guidelines. 
1.5. Click the Next button in the pop-up. 

2. General tab  
2.1. Complete the required fields.  
2.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.) 

3. Applicant tab 
3.1. Confirm that you are a Canadian Resident.  
3.2. Complete the required fields. 
3.3. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

4. Exporter tab 
4.1. Click the Same as Applicant checkbox, or manually complete the required fields.  
4.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

5. Consignee tab 
5.1. Complete the required fields.  
5.2. Click on the Accept button in the application to save. (If any mistakes are made while completing 

the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click the Accept button to save.) 

5.3. To add an additional consignee record, click on the Add Consignee button in the application and 
repeat step 5.1. onwards. Once you have added your consignee(s), click on one of the two Next 
buttons in the application to continue.  

6. Items tab 
6.1. Complete the required fields. 
6.2. Click the Accept button in the application to proceed. (If any mistakes are made while completing 

the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click the Accept button to proceed.) 

6.3. To add an additional ECL record, click on the Add Item button in the application and repeat step 
6.1. onwards. Once you have added your ECL code(s), click the Accept button in the application to 
save. (If any mistakes are made while completing the form, an error message will appear on the 
application advising you on what to modify. Correct the errors. Click the Accept button to save.) 

6.4. To add an additional item record, click on the Add Item button in the application and repeat step 
6.1. onwards. Once you have added your item(s), click on one of the two Next buttons in the 
application to continue. 

7. Documents tab: Click the Add Document button in the application if they are required to meet your 
application requirements or if you would like to add document(s), and see step 7.1. If you do not 
want to add documents, click on one of the two Next buttons in the application to continue and see 
step 8. 

7.1. Complete the required fields.  
7.2. Click on the Accept button in the application to save. (If any mistakes are made while completing 

the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click the Accept button to save.) 
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7.3. To add an additional document record, click on the Add Document button in the application and 
repeat step 7.1. onwards.  Once you have added your document(s), click on one of the two Next 
buttons in the application to continue.  

8. Distribution tab 
8.1. Complete the required fields. 
8.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

9. Applicant Confirmation tab 
9.1. Complete the required fields. 
9.2. Click on one of the two Submit buttons in the application to complete your permit submission. (If 

any mistakes are made while completing the form, an error message will appear on the 
application advising you on what to modify. Correct the errors. Click one of the two Submit 
buttons to continue.) 

10. Confirmation of Application Submission 
10.1. You have now completed your application submission. You will be prompted to leave feedback on 

your experience using the Walk-Through. To provide feedback please send an email to the 
following address: feedback-commentaire.tia@international.gc.ca. 

OCG: SmartTips 
OCG: General tab 
1. Export Type (Tooltip):  Select "Temporary" if the goods you are exporting are returning to Canada. 
2. Overall Description and End-Use (ToolTip): Refer to section E.3.4. “EXCOL Field:  Overall Description 

of goods and End-Use” of the Export and Brokering Controls Handbook for guidance on appropriate 
descriptions. 

3. Applicant comments (Mouseover): Applicant Comments will only be visible to Permit Officers and 
will not be printed on the permit. 

OCG: Consignees Tab 
1. Name (ToolTip): The Consignee is the foreign party or parties who will be importing the goods or 

technology from the Canadian exporter into a foreign country. Refer to section E.3.3. 'EXCOL Field: 
Consignee information' of the Export and Brokering Controls Handbook for additional guidance. 

 

OCG: Items Tab 
1. Description (ToolTip): Refer to section E.3.7. “EXCOL Field: Description" of the Export and Brokering 

Controls Handbook for guidance on appropriate descriptions. 
2. U.S. Content Percentage (ToolTip): U.S.-origin value is an estimated percentage of the total value in 

Canadian dollars. Refer to section E.3.9. "EXCOL Field: U.S. Content” and section E.4.3. "U.S. Export 
Authorization” of the Export and Brokering Controls Handbook for additional information. 

3. Please Select One or More ECLs (ToolTip): Please enter the ECL entries that matches the nature of 
the goods tendered for export. If there are multiple items you can enter multiple ECLs. If you do not 
know the ECLs number for your goods, or which ECL applies, you may enter "Unknown". You can 
select "Not Controlled" if the items are not included on the ECL and you need a confirmation from 
GAC. 

4. Other ECL (ToolTip): If you do not find the ECL that matches your goods in the list above, you may 
enter another ECL in this field and add it to the above. You may also add other types of controls 
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including other regulatory progress codes, you do not know the exact ECL of goods (ECCN / US 
Commerce Control List, Wassenaar, etc) 

OCG: Documents Tab 
1. Documents (ToolTip): Please refer to section E.4 “Mandatory Supporting Documentation” of the 

Export and Brokering Controls Handbook for guidance on appropriate documentation. 
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Advisory Opinion (AO) 
AO: Application Walk-Through 
AO: How to Access the Walk-Through 
You can access the Advisory Opinion (AO) Walk-Through in three ways.  

AO: From the Website Guide launcher 
1. Click the Website Guide launcher (on all New EXCOL pages). 
2. On the Website Guide pop-up click the Apply link.  
3. On the Apply pop-up click the Export Permit Applications link. 
4. On the Export Permit Applications pop-up click the Advisory Opinion (AO) link. This will launch a 

pop-up advising you that in beginning this application Walk-Through, you may loose any unsaved 
information.  

5. Click the Start button in the pop-up. You will be redirected to the Terms of User and Privacy 
Statement page. 

6. Click the I Agree button in the application. You will be redirected to the Advisory Opinion (AO) 
application webpage. See section AO: Walk-Through Steps. (The pop-up also gives you the option to 
cancel the Walk-Through. Click the Cancel button in the pop-up to stop the Walk-Through.) 

AO: From the WalkMe Help Menu launcher  
1. Click the WalkMe Help Menu launcher (large question mark icon at the bottom of all New EXCOL 

pages).  
2. On the Help Menu-WalkMe pop-up, click the Step by Step Application Walk-Throughs drop down 

link.  
3. From the drop down, click the Apply – Advisory Opinion (AO) link. This will launch a pop-up advising 

you that in beginning this application Walk-Through, you may loose any unsaved information. 
4. Click the Start button in the pop-up. You will be redirected to the Terms of User and Privacy 

Statement page. 
5. Click the I Agree button in the application. You will be redirected to the Advisory Opinion (AO) 

application webpage. See section AO: Walk-Through Steps. (The pop-up also gives you the option to 
cancel the Walk-Through. Click the Cancel button in the pop-up to stop the Walk-Through.) 

AO: From the Help launcher on the General page 
1. Click the Help launcher on the General page of the Advisory Opinion (AO) Application. See section 

AO: Walk-Through Steps. 

AO: Walk-Through Step 
1. Application Walk-Through disclaimer 
1.1. A pop-up advises you that by following the Advisory Opinion (AO) application Walk-Through you 

will be submitting an actual application. 
1.2. Click the Start button in the pop-up. (The pop-up also gives you the option to cancel the Walk-

Through. Click the Cancel button in the pop-up to stop the Walk-Through.) 
2. General tab  
2.1. Complete the required fields.  
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2.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 
while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.) 

3. Applicant tab 
3.1. Confirm that you are a Canadian Resident.  
3.2. Complete the required fields.  
3.3. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.) 

4. Exporter tab 
4.1. Click the Same as Applicant checkbox, or manually complete the required fields.  
4.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.) 

5. Consignee tab: A consignee is not required for an Advisory Opinion application. It is important to 
note that if you plan to export, you should apply for an Export Permit. For more information about 
Advisory Opinion, see the Advisory Opinions. Click the Add New Consignee button in the application 
if you would like to add consignee(s), and see step 5.1. If you do not want to add consignees, click on 
one of the two Next buttons in the application to continue and see step 6. 

5.1. Complete the required fields.  
5.2. Click on the Accept button in the application to save. (If any mistakes are made while completing 

the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click the Accept button to save.)  

5.3. To add an additional consignee record, click on the Add Consignee button in the application and 
repeat step 5.1. onwards. Once you have added your consignee(s), click on one of the two Next 
buttons in the application to continue.  

6. Items tab 
6.1. Complete the required fields.  
6.2. Click the Accept button in the application to record the ECL Code. (If any mistakes are made while 

completing the form, an error message will appear on the application advising you on what to 
modify. Correct the errors. Click the Accept button to proceed.) 

6.3. To add an additional ECL record, click on the Add Item button in the application and repeat step 
6.1. onwards. Once you have added your ECL code(s), click the Accept button in the application to 
continue. (If any mistakes are made while completing the form, an error message will appear on 
the application advising you on what to modify. Correct the errors. Click the Accept button to 
save.) 

6.4. To add an additional item record, click on the Add Item Item button in the application and repeat 
step 6.1. onwards. Once you have added your item(s), click on one of the two Next buttons in the 
application to continue. 

7. Documents tab: Click the Add Document button in the application if they are required to meet your 
application requirements or if you would like to add document(s), and see step 7.2. If you do not 
want to add documents, click on one of the two Next buttons in the application to continue and see 
step 8.  

7.1. Complete the required fields.  



22 
 

7.2. Click on the Accept button in the application to save. (If any mistakes are made while completing 
the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click the Accept button to save.) 

7.3. To add an additional document record, click on the Add Document button in the application and 
repeat step 7.2. onwards. Once you have added your document(s), click on one of the two Next 
buttons in the application to continue. 

8. Distribution tab 
8.1. Complete the required fields.  
8.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

9. Applicant Confirmation tab 
9.1. Complete the required fields. 
9.2. Click on one of the two Submit buttons in the application to complete your permit submission. (If 

any mistakes are made while completing the form, an error message will appear on the 
application advising you on what to modify. Correct the errors. Click one of the two Submit 
buttons to continue.) 

10. Confirmation of Application Submission 
10.1. You have now completed your application submission. You will be prompted to leave feedback on 

your experience using the Walk-Through. To provide feedback please send an email to the 
following address: feedback-commentaire.tia@international.gc.ca. 

AO: SmartTips 
AO: General tab 
1. Overall Description and End-Use (ToolTip): Refer to section E.3.4. “EXCOL Field:  Overall Description 

of goods and End-Use” of the Export and Brokering Controls Handbook for guidance on appropriate 
descriptions. 

2. Applicant comments (Mouseover): Applicant Comments will only be visible to Permit Officers and 
will not be printed on the permit. 

AO: Consignee tab 
1. Name (Tooltip): The Consignee is the foreign party or parties who will be importing the goods or 

technology from the Canadian exporter into a foreign country. Refer to section E.3.3. 'EXCOL Field: 
Consignee information' of the Export and Brokering Controls Handbook for additional guidance. 

AO: Items tab 
1. Description (Tooltip): Refer to section E.3.7 “EXCOL Field:  Description" of the Export and Brokering 

Controls for guidance on appropriate descriptions. 
2. U.S. Content (%) (Tooltip): U.S.-origin value is an estimated percentage of the total value in 

Canadian dollars. Refer to section E.3.9. "EXCOL Field: U.S. Content” and section E.4.3. "U.S. Export 
Authorization” of the Export and Brokering Controls Handbook for additional information. 

3. Please select one or more ECLs (Tooltip): Consult A Guide to Canada’s Export Control List (ECL) to 
determine which of the ECL Items apply to your item. Do not use Harmonized System (HS) codes. 
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Do not use Harmonized System (HS) codes. It is possible that multiple ECL Items are applicable, or 
that none apply. 

AO: Documents tab 
1. Documents (ToolTip): Please refer to section E.4 “Mandatory Supporting Documentation” of the 

Export and Brokering Controls Handbook for guidance on appropriate documentation. 
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Delivery Verification Certificate (DVC) 
DVC: Application Walk-Through 
DVC: How to Access the Walk-Through 
You can access the Delivery Verification Certificate (DVC) Walk-Through in three ways.  

DVC: From the Website Guide launcher 
1. Click the Website Guide launcher (on all New EXCOL pages). 
2. On the Website Guide pop-up click the Apply link.  
3. On the Apply pop-up click the Export Permit Applications link. 
4. On the Export Permit Applications pop-up click the Delivery Verification Certificate (DVC) link. This 

will launch a pop-up advising you that in beginning this application Walk-Through, you may loose 
any unsaved information.  

5. Click the Start button in the pop-up. You will be redirected to the Terms of User and Privacy 
Statement page. 

6. Click the I Agree button in the application. You will be redirected to the Delivery Verification 
Certificate (DVC) application webpage. See section DVC: Walk-Through Steps. (The pop-up also gives 
you the option to cancel the Walk-Through. Click the Cancel button in the pop-up to stop the Walk-
Through.) 

DVC: From the WalkMe Help Menu launcher  
1. Click the WalkMe Help Menu launcher (large question mark icon at the bottom of all New EXCOL 

pages).  
2. On the Help Menu-WalkMe pop-up, click the Step by Step Application Walk-Throughs drop down 

link.  
3. From the drop down, click the Apply – Delivery Verification Certificate (DVC) link. This will launch a 

pop-up advising you that in beginning this application Walk-Through, you may loose any unsaved 
information. 

4. Click the Start button in the pop-up. You will be redirected to the Terms of User and Privacy 
Statement page. 

5. Click the I Agree button in the application. will be redirected to the Delivery Verification Certificate 
(DVC) application webpage. See section DVC: Walk-Through Steps. (The pop-up also gives you the 
option to cancel the Walk-Through. Click the Cancel button in the pop-up to stop the Walk-
Through.) 

DVC: From the Help launcher on the General page 
1. Click the Help launcher on the General page of the Delivery Verification Certificate (DVC) 

Application. See section DVC: Walk-Through Steps. 

DVC: Walk-Through Step 
1. Application Walk-Through disclaimer 
1.1. A pop-up advises you that by following the Delivery Verification Certificate (DVC) application 

Walk-Through you will be submitting an actual application. 
1.2. Click the Start button in the pop-up. (The pop-up also gives you the option to cancel the Walk-

Through. Click the Cancel button in the pop-up to stop the Walk-Through.)  
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1.3. A pop-up advises you to click the Application Guidelines dropdown menu to view information 
specific to your application. 

1.4. Read the Application Guidelines. 
1.5. Click the Next button in the pop-up. 
2. General tab  
2.1. Complete the required fields.  
2.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.) 

3. Applicant tab 
3.1. Confirm that you are a Canadian Resident.  
3.2. Complete the required fields.  
3.3. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

4. Importer tab 
4.1. Click the Same as Applicant checkbox, or manually complete the required fields.  
4.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

5. Exporter tab 
5.1. Complete the required fields.  
5.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

6. Items tab 
6.1. Complete the required fields. 
6.2. Click on the Accept button in the application to save. (If any mistakes are made while completing 

the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click the Accept button to save.) 

6.3. To add an additional item record, click on the Add Item button in the application and repeat step 
6.1. onwards. Once you have added your item(s), click on one of the two Next buttons in the 
application to continue.  

7. Documents tab: Click the Add Document button in the application if they are required to meet your 
application requirements or if you would like to add document(s), and see step 7.1. If you do not 
want to add documents, click on one of the two Next buttons in the application to continue and see 
step 8. 

7.1. Complete the required fields. 
7.2. Click on Accept button in the application to save. (If any mistakes are made while completing the 

form, an error message will appear on the application advising you on what to modify. Correct the 
errors. Click the Accept button to save.) 

7.3. To add an additional document record, click on the Add Document button in the application and 
repeat step 7.2. onwards. Once you have added your document(s), click on one of the two Next 
buttons in the application to continue. 
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8. Distribution tab 
8.1. Complete the required fields.  
8.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

9. Applicant Confirmation tab 
9.1. Complete the required fields.  
9.2. Click on one of the two Submit buttons in the application to complete your permit submission. (If 

any mistakes are made while completing the form, an error message will appear on the 
application advising you on what to modify. Correct the errors. Click one of the two Submit 
buttons to continue.) 

10. Confirmation of Application Submission 
10.1. You have now completed your application submission. You will be prompted to leave feedback on 

your experience using the Walk-Through. To provide feedback please send an email to the 
following address: feedback-commentaire.tia@international.gc.ca. 

DVC: Smart Tips 
DVC: Documents Tab 
1. Documents (ToolTip): Please refer to section E.4 “Mandatory Supporting Documentation” of the 

Export and Brokering Controls Handbook for guidance on appropriate documentation. 
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International Import Certificate (IIC) 
IIC: Application Walk-Through 
IIC: How to Access the Walk-Through 
You can access the International Import Certificate (IIC) Walk-Through in three ways.  

IIC: From the Website Guide launcher 
1. Click the Website Guide launcher (on all New EXCOL pages). 
2. On the Website Guide pop-up click the Apply link.  
3. On the Apply pop-up click the Export Permit Applications link. 
4. On the Export Permit Applications pop-up click the International Import Certificate (IIC) link. This 

will launch a pop-up advising you that in beginning this application Walk-Through, you may loose 
any unsaved information.  

5. Click the Start button in the pop-up. You will be redirected to the Terms of User and Privacy 
Statement page. 

6. Click the I Agree button in the application. You will be redirected to the Delivery Verification 
Certificate (DVC) application webpage. See section IIC: Walk-Through Steps. (The pop-up also gives 
you the option to cancel the Walk-Through. Click the Cancel button in the pop-up to stop the Walk-
Through. 

IIC: From the WalkMe Help Menu launcher 
1. Click the WalkMe Help Menu launcher (large question mark icon at the bottom of all New EXCOL 

pages).  
2. On the Help Menu-WalkMe pop-up, click the Step by Step Application Walk-Throughs drop down 

link.  
3. From the drop down, click the International Import Certificate (IIC) link. This will launch a pop-up 

advising you that in beginning this application Walk-Through, you may loose any unsaved 
information. 

4. Click the Start button in the pop-up. You will be redirected to the Terms of User and Privacy 
Statement page. 

5. Click the I Agree button in the application. You will be redirected to the Delivery Verification 
Certificate (DVC) application webpage. See section IIC: Walk-Through Steps. (The pop-up also gives 
you the option to cancel the Walk-Through. Click the Cancel button in the pop-up to stop the Walk-
Through. 

IIC: From the Help launcher on the General page 
1. Click the Help launcher on the General page of the Delivery Verification Certificate (DVC) 

Application. See section IIC: Walk-Through Steps. 

IIC: Walk-Through Step 
1. Application Walk-Through disclaimer. 
1.1. A pop-up advises you that by following the Delivery Verification Certificate (DVC) application 

Walk-Through you will be submitting an actual application. 
1.2. Click the Start button in the pop-up. (The pop-up also gives you the option to cancel the Walk-

Through. Click the Cancel button in the pop-up to stop the Walk-Through. 
1.3. A pop-up advises you to click the Application Guidelines dropdown menu to view information 

specific to your application. 
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1.4. Read the Application Guidelines. 
1.5. Click the Next button in the pop-up. 
2. General tab 
2.1. Complete the required fields. 
2.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.) 

3. Applicant tab 
3.1. Confirm that you are a Canadian Resident.  
3.2. Complete the required fields.  
3.3. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

4. Importer tab 
4.1. Click the Same as Applicant checkbox, or manually complete the required fields.  
4.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

5. Exporter tab 
5.1. Complete the required fields. 
5.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.) 

6. End User tab 
6.1. Complete the required fields. 
6.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.) 

7. Items tab 
7.1. Complete the required fields. 
7.2. Click on the Accept button in the application to save. (If any mistakes are made while completing 

the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click the Accept button to save.) 

7.3. To add an additional item record, click on the Add Item button in the application and repeat step 
6.1. onwards.  Once you have added your item(s), click on one of the two Next buttons in the 
application to continue. 

8. Documents tab: Click the Add Document button in the application if they are required to meet your 
application requirements or if you would like to add document(s), and see step 7.1. If you do not 
want to add documents, click on one of the two Next buttons in the application to continue and see 
step 8. 

8.1. Complete the required fields.  
8.2. Click on the Accept button in the application to save. (If any mistakes are made while completing 

the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click the Accept button to save.) 

8.3. To add an additional document record, click on the Add Document button in the application and 
repeat step 7.2. onwards. Once you have added your document(s), click on one of the two Next 
buttons in the application to continue. 

9. Distribution tab 
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9.1. Complete the required fields. 
9.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

10. Applicant Confirmation tab 
10.1. Complete the required fields. 
10.2. Click on one of the two Submit buttons in the application to complete your permit submission. (If 

any mistakes are made while completing the form, an error message will appear on the 
application advising you on what to modify. Correct the errors. Click one of the two Submit 
buttons to continue.) 

11. Confirmation of Application Submission 
11.1. You have now completed your application submission. You will be prompted to leave feedback on 

your experience using the Walk-Through. To provide feedback please send an email to the 
following address: feedback-commentaire.tia@international.gc.ca. 

IIC: Smart Tips 
IIC: Documents Tab 
1. Documents (ToolTip): Please refer to section E.4 “Mandatory Supporting Documentation” of the 

Export and Brokering Controls Handbook for guidance on appropriate documentation. 
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General Export Permit (GEP) 
GEP: Application Walk-Through 
GEP: How to Access the Walk-Through 
You can access the General Export Permit (GEP) Walk-Through in three ways.  

GEP: From the Website Guide launcher 
1. Click the Website Guide launcher (on all New EXCOL pages). 
2. On the Website Guide pop-up click the Apply link.  
3. On the Apply pop-up click the Export Permit Applications link. 
4. On the Export Permit Applications pop-up click the General Export Permit (GEP) link. This will 

launch a pop-up advising you that in beginning this application Walk-Through, you may loose any 
unsaved information.  

5. Click the Start button in the pop-up. You will be redirected to the Terms of User and Privacy 
Statement page. 

6. Click the I Agree button in the application. You will be redirected to the General Export Permit 
(GEP) application webpage. See section GEP: Walk-Through Steps. (The pop-up also gives you the 
option to cancel the Walk-Through. Click the Cancel button in the pop-up to stop the Walk-
Through.) 

GEP: From the WalkMe Help Menu launcher 
1. Click the WalkMe Help Menu launcher (large question mark icon at the bottom of all New EXCOL 

pages).  
2. On the Help Menu-WalkMe pop-up, click the Step by Step Application Walk-Throughs drop down 

link.  
3. From the drop down, click the General Export Permit (GEP) link. This will launch a pop-up advising 

you that in beginning this application Walk-Through, you may loose any unsaved information. 
4. Click the Start button in the pop-up. You will be redirected to the Terms of User and Privacy 

Statement page. 
5. Click the I Agree button in the application. You will be redirected to the General Export Permit 

(GEP) application webpage. See section GEP: Walk-Through Steps. (The pop-up also gives you the 
option to cancel the Walk-Through. Click the Cancel button in the pop-up to stop the Walk-
Through.) 

GEP: From the Help launcher on the General page  
1. Click the Help launcher on the General page of the General Export Permit (GEP) Application. See 

section GEP: Walk-Through Steps. 

GEP: Walk-Through Step 
1. Application Walk-Through disclaimer 
1.1. A pop-up advises you that by following the General Export Permit (GEP) application Walk-

Through you will be submitting an actual application. 
1.2. Click the Start button in the pop-up. (The pop-up also gives you the option to cancel the Walk-

Through. Click the Cancel button in the pop-up to stop the Walk-Through.)  
1.3. A pop-up advises you to click the Application Guidelines dropdown menu to view information 

specific to your application. 
1.4. Read the Application Guidelines. 
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1.5. Click the Next button in the pop-up. 
2. General Tab  
2.1. Complete the required fields.  
2.2. Click on one of the two Next buttons to continue. (If any mistakes are made while completing the 

form, an error message will appear on the application advising you on what to modify. Correct the 
errors. Click one of the two Next buttons to continue.) 

3. Applicant Tab  
3.1. Confirm that you are a Canadian Resident  
3.2. Complete the required fields. 
3.3. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

4. Exporter Tab  
4.1. Verify the required fields. 
4.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

5. GEP Tab  
5.1. Complete the required fields. 
5.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

6. Documents Tab: There is no requirement for supporting documents for General Export Permit (GEP) 
pre-notification. Your reporting documentation is required at the end of the year and must be 
uploaded to the GEP Documents tab. Click the Add Document button in the application if you would 
like to add document(s), and see step 6.1. If you do not want to add documents, click on one of the 
two Next buttons in the application to continue and see 7.  

6.1. Complete the required fields. 
6.2. Click on the Accept button in the application to save. (If any mistakes are made while completing 

the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click the Accept button to save.) 

6.3. To add an additional document record, click on the Add Document button in the application and 
repeat step 6.1. onwards. Once you have added your document(s), click on one of the two Next 
buttons in the application to continue.  

7. Distribution Tab 
7.1. Complete the required fields. 
7.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

8. Applicant Confirmation Tab 
8.1. Complete the required fields. 
8.2. Click on one of the two Submit buttons in the application to complete your permit submission. (If 

any mistakes are made while completing the form, an error message will appear on the 
application advising you on what to modify. Correct the errors. Click one of the two Submit 
buttons to continue.) 

9. Confirmation of Application Submission 
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9.1. You have now completed your application submission. You will be prompted to leave feedback on 
your experience using the Walk-Through. To provide feedback please send an email to the 
following address: feedback-commentaire.tia@international.gc.ca. 

GEP: SmartTips 
GEP: General Tab 
1. Applicant comments (Mouseover): Applicant Comments will only be visible to Permit Officers and 

will not be printed on the permit. 

GEP: Documents Tab 
1. Documents (ToolTip): There is no requirement for supporting documents for General Export Permit 

(GEP) pre-notification.  Your reporting documentation is required at the end of the year and must be 
uploaded to the GEP Documents tab. 
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Brokering Permit (BP) 
BP: Application Walk-Through 
BP: How to Access the Walk-Through 
You can access the Brokering Permit (BP) Walk-Through in three ways.  

BP: From the Website Guide launcher 
1. Click the Website Guide launcher (on all New EXCOL pages). 
2. On the Website Guide pop-up click the Apply link.  
3. On the Apply pop-up click the Export Permit Applications link. 
4. On the Export Permit Applications pop-up click the Brokering Permit (BP) link. This will launch a 

pop-up advising you that in beginning this application Walk-Through, you may loose any unsaved 
information.  

5. Click the Start button in the pop-up. You will be redirected to the Terms of User and Privacy 
Statement page. 

6. Click the I Agree button in the application. You will be redirected to the Brokering Permit (BP) 
application webpage. See section BP: Walk-Through Steps. (The pop-up also gives you the option to 
cancel the Walk-Through. Click the Cancel button in the pop-up to stop the Walk-Through.) 

BP: From the WalkMe Help Menu launcher  
7. Click the WalkMe Help Menu launcher (large question mark icon at the bottom of all New EXCOL 

pages).  
8. On the Help Menu-WalkMe pop-up, click the Step by Step Application Walk-Throughs drop down 

link.  
9. From the drop down, click the Brokering Permit (BP) link. This will launch a pop-up advising you that 

in beginning this application Walk-Through, you may loose any unsaved information. 
10. Click the Start button in the pop-up. You will be redirected to the Terms of User and Privacy 

Statement page. 
11. Click the I Agree button in the application. You will be redirected to the Brokering Permit (BP) 

application webpage. See section BP: Walk-Through Steps. (The pop-up also gives you the option to 
cancel the Walk-Through. Click the Cancel button in the pop-up to stop the Walk-Through.) 

BP: From the Help launcher on the General page  
12. Click the Help launcher on the General page of the Brokering Permit (BP) Application. See section 

BP: Walk-Through Steps. 

BP: Walk-Through Step 
1. Application Walk-Through disclaimer 
1.1. A pop-up advises you that by following the Brokering Permit (BP) application Walk-Through you 

will be submitting an actual application. 
1.2. Click the Start button in the pop-up. (The pop-up also gives you the option to cancel the Walk-

Through. Click the Cancel button in the pop-up to stop the Walk-Through.) 
1.3. A pop-up advises you to click the Application Guidelines dropdown menu to view information 

specific to your application. 
1.4. Read the Application Guidelines. 
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1.5. Click the Next button in the pop-up. 
2. General Tab  
2.1. Complete the required fields. 
2.2. Click on one of the two Next buttons to continue. (If any mistakes are made while completing the 

form, an error message will appear on the application advising you on what to modify. Correct the 
errors. Click one of the two Next buttons to continue.) 

3. Applicant Tab1  
3.1. Confirm that you are a Canadian Resident.  
3.2. Complete the required fields.  
3.3. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.) Erreur ! Signet non 
défini. 

4. Seller Tab  
4.1. Complete the required fields. 
4.2. Click on the Accept button in the application to save. (If any mistakes are made while completing 

the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click the Accept button to save.) 

4.3. To add an additional Seller, click on the Add Seller button in the application and repeat step 4.1. 
onwards. Once you have added your Seller(s), click on one of the two Next buttons in the 
application to continue 

5. Purchaser Tab  
5.1. Complete the required fields. 
5.2. Click on the Accept button in the application to save. (If any mistakes are made while completing 

the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click the Accept button to save.) 

5.3. To add an additional Seller, click on the Add Purchaser button in the application and repeat step 
5.1 onwards. Once you have added your Purchaser(s), click on one of the two Next buttons in the 
application to continue. 

6. Consignee tab 
6.1. Complete the required fields. 
6.2. Click on the Accept in the application button to save. (If any mistakes are made while completing 

the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click the Accept button to save.) 

6.3. To add an additional consignee record, click on the Add Consignee button in the application and 
repeat step 6.1. onwards.  Once you have added your consignee(s), click on one of the two Next 
buttons in the application to continue. 

7. Nature of Items Tab  
7.1. Complete the required fields. 

                                                           
1 The following SmartTip is found on the Applicant tab: 
Name (Tooltip): See section E.6 “How to Complete an Application for Brokering Permits” of the Export and Brokering Controls 
Handbook for additional guidance. 
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7.2. Click on one of the two Next buttons to continue. (If any mistakes are made while completing the 
form, an error message will appear on the application advising you on what to modify. Correct the 
errors. Click one of the two Next buttons to continue.)  

8. Items Tab  
8.1. Select an Item Type from the dropdown list. 
8.2. Complete the required fields. 
8.3. Click on the Accept button in the application to save. (If any mistakes are made while completing 

the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click the Accept button to save.) 

8.4. To add an additional item record, click on the Add Item button in the application and repeat step 
8.1. onwards. Once you have added your item(s), click on one of the two Next buttons in the 
application to continue. 

9. Documents Tab: Click the Add Document button in the application if they are required to meet your 
application requirements or if you would like to add document(s), and see step 9.1. If you do not 
want to add documents, click on one of the two Next buttons in the application to continue and see 
step 10. 

9.1. Complete the required fields. 
9.2. Click on the Accept button in the application to save. (If any mistakes are made while completing 

the form, an error message will appear on the application advising you on what to modify. Correct 
the errors. Click the Accept button to save.)  

9.3. To add an additional document record, click on the Add Document button in the application and 
repeat step 9.2. onwards. Once you have added your document(s), click on one of the two Next 
buttons in the application to continue. 

10. Distribution Tab 
10.1. Complete the required fields. 
10.2. Click on one of the two Next buttons in the application to continue. (If any mistakes are made 

while completing the form, an error message will appear on the application advising you on what 
to modify. Correct the errors. Click one of the two Next buttons to continue.)  

11. Applicant Confirmation Tab 
11.1. Complete the required fields. 
11.2. Click on one of the two Submit buttons in the application to complete your permit submission. (If 

any mistakes are made while completing the form, an error message will appear on the 
application advising you on what to modify. Correct the errors. Click one of the two Submit 
buttons to continue.) 

12. Confirmation of Application Submission 
12.1. You have now completed your application submission. You will be prompted to leave feedback on 

your experience using the Walk-Through. To provide feedback please send an email to the 
following address: feedback-commentaire.tia@international.gc.ca. 
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BP: SmartTips and ShoutOuts 
BP: General Tab 
1. Overall Description and End-Use (ToolTip): Refer to section E.3.4. “EXCOL Field:  Overall Description 

of goods and End-Use” of the Export and Brokering Controls Handbook for guidance on appropriate 
descriptions. 

2. Applicant comments (Mouseover): Applicant Comments will only be visible to Permit Officers and 
will not be printed on the permit. 

BP: Applicant Tab 
1. Name (Tooltip): See section E.6 “How to Complete an Application for Brokering Permits” of the 

Export and Brokering Controls Handbook for additional guidance. 

BP: Sellers Tab 
1. Name (Tooltip): Refer to section E.6.3. "EXCOL Field: Purchaser information" of the Export and 

brokering controls handbook for additional guidance. 

BP: Sellers Tab 
1. Name (Tooltip): Refer to section E.6.2. "EXCOL Field: Seller information" of the Export and brokering 

controls handbook for additional guidance. 

BP: Consignee tab 
1. Type (Tooltip): The Consignee is the foreign party or parties who will be importing the goods or 

technology from the Canadian exporter into a foreign country. Refer to section E.3.3. 'EXCOL Field: 
Consignee information' of the Export and Brokering Controls Handbook for additional guidance. 

2. Type (ShoutOut): Brokering Permit Consignee Types Definition 

2.1. Intermediary: Any foreign mediator in a transaction that relates to the movement of controlled 
goods or technology from one foreign country to another.  

2.2. Final end-user: The entity that employs or uses the goods or technology that were exported from 
one third country to another, for the purpose for which they were intended.  

2.3. Other broker: Any foreign entity that is outside of Canada and is arranging or negotiating a 
transaction that relates to the movement of the controlled goods or technology in question from 
one foreign country to another. The “applicant” and the “broker” are not the same in this case. 

2.4. Agent: A foreign entity that is authorized to act for or in the place of another foreign entity that is 
involved in the brokering transaction. 

2.5. Mandatary: A person to whom the power to transact business for another is given under a 
mandate. 

3. Name (Tooltip): The Consignee is the foreign party or parties who will be importing the goods or 
technology from the Canadian exporter into a foreign country. Refer to section E.3.3. 'EXCOL Field: 
Consignee information' of the Export and Brokering Controls Handbook for additional guidance 

BP: Items Tab 
BP: BP Firearm  
1. Description (Tooltip): Refer to section E.3.7 “EXCOL Field:  Description" of the Export and Brokering 

Controls Handbook for guidance on appropriate descriptions. 
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2. Canadian Firearms Legal Classification (Launcher) 
3. Calibre (Tooltip): For "Receiver Blank" or "Receiver Only", enter Calibre = N/A. The Calibre Tooltip 

only appears when the Type is “Receiver Blank” or “Receiver Only”. 
4. Please select which paragraph of the Brokering Control List (BCL) is applicable to this item 

(Tooltip): For assistance, please consult the Export and Brokering Controls Handbook. 
5. BCL Guide (Launcher) 

BP: Other Controlled Good or Technology 
1. Description (Tooltip): Refer to section E.3.7 “EXCOL Field:  Description" of the Export and Brokering 

Controls for guidance on appropriate descriptions. 
2. U.S. Content (%) (Tooltip): U.S.-origin value is an estimated percentage of the total value in 

Canadian dollars. Refer to section E.3.9. "EXCOL Field: U.S. Content” and section E.4.3. "U.S. Export 
Authorization” of the Export and Brokering Controls Handbook for additional information. 

3. Please select which paragraph of the Brokering Control List (BCL) is applicable to this item 
(Tooltip): For assistance, please consult the Export and Brokering Controls Handbook. 

4. BCL Guide (Launcher) 

BP: Documents Tab 
1. Documents (ToolTip): Please refer to section E.4 “Mandatory Supporting Documentation” of the 

Export and Brokering Controls Handbook for guidance on appropriate documentation.  


